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Feedback

Jive (AppleTalk) Talkin’ Correction
It appears there is an error in the “Jive 

(AppleTalk) Talkin’” tip in the February 
issue, because the firmware rejects the 
commands “resetnvram” “setdefaults” and 

“resetall” but responds just fine if hyphens 
are added: “reset-nvram” “set-defaults” and 

“reset-all” work, and each returns an “OK” 
upon pressing RETURN, and ultimately 
the Mac runs the appropriate routines.

How did I figure this out? I didn’t. I 
performed a Google search.

Here are hyperlinks to a few pages that 
mention the hyphenation:
•	 http://www.regularjen.com/geeky-girlie/

reset-nvram/
•	 http://www.appletechs.com/

archives/00000043.html
•	 http://www.xlr8yourmac.com/archives/

mar03/031703.html
Stan Coutant

Move Thru Those Apps
A couple of times people have referred 

to switching applications by pressing 
Command/Tab.

What I discovered by accident is that, 
having pressed Command/Tab once, you 
can then move the mouse over the app that 
you want (so it’s highlighted) then let go.  
This is faster than using Command/Tab if 
you have a load of apps open.

John Law 
University of Newcastle upon Tyne, UK

General

Empty the Trash Automatically with 
AppleScript

One option that’s missing for many in 
the Finder is the ability to automatically 
empty the Trash as you drop an item 
onto the Trash Can icon. Fortunately, it’s 
possible by setting up a simple Folder 
Action with an AppleScript. One word of 
warning  —  once you set this up, any item 
you drop onto the Trash Can in the Dock 
will automatically be deleted from the hard 
drive, so consider this option carefully. 
Should you decide to proceed, launch the 
Script Editor and in it, enter the following 
script:
on adding folder items to 

this _ folder after
receiving added _ items
try
tell application “Finder” to 

empty trash
end try
end adding folder items to

When you’ve completed the script, name 
the script “emptytrash” and save the file as 
a script in Library/Scripts/Folder Action 
Scripts. Now, choose Go > Go To Folder, 
enter ~/.Trash and click the “Go” button. 
The Finder then displays the hidden trash 
folder. Next, Control/click on the .Trash 
folder and choose the “Attach A Folder 
Action” option. Then, in the open “Choose 
A File” dialog box, select the “emptytrash” 
script. With that script assigned as a Folder 

Welcome!
These tips have been 

culled from user group 
newsletters, Macintosh-
related books, magazines, 
and other sources. Thanks 
to all who have contributed 
and provided this valuable 
information to the 
Macintosh community.

This weekend was 
the Academy Awards 
Presentation. This year’s 
show is being hosted by Jon 
Stewart, the host of the Daily 
Show, a faux news program 
on Comedy Central, a cable 
channel.

The Daily Show and the 
following program, The 
Colbert Report with Steven 
Colbert, cover topical news 
subjects and interviews with 
a humorous slant. Here in 
San Diego, the shows are on 
from 11pm until midnight, 
too late for me to watch live, 
so I record them on a digital 
video recorder (a TiVO 
copycat) and watch them the 
next evening. 

I recommend you check 
out both shows.

— Paul Taylor 
paul@mac-hints-tips.com
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Action, the Trash will automatically 
empty whenever an item is moved 
into it.

TMUG Insider, Pleasanton, CA

I Want My NTFS!
Q: Why can’t I use NTFS-

formatted volumes in Mac OS X?
A: NTFS (NT file system, as 

in Windows NT) is a proprietary 
Microsoft format. As of Mac 
OS 10.3.5, Macs can mount 
NTFS volumes as read-only, but 
command-line jocks can get limited 
write access via the mount_ntfs 
command — learn all about it by 
typing man mount ....ntfs in OS X’s 
Terminal (/Applications/Utilities).

MacAddict Magazine

Upgrade Options
Q: I would like to upgrade the 

memory and hard disk on two 
iMacs: a 400MHz iMac DV and a 
600MHz iMac. Can I use PC133 
memory chips instead of PC100? 
And is it true that you can increase 
the memory limit on the 400MHz 
iMac from 512MB to 1GB? What 
options do I have for the hard 
drives? ~ Larry Kidd

A: This is one of those “Teach 
a man to fish” questions I like so 
much. I can tell you that, yes, you 
can use PC133 RAM in your iMac 
and that, yes, your iMac supports 
as much as a gigabyte of RAM. But 
my answer will be more helpful to 
others if I point you to a couple of 
good sources for finding all you 
need to know about Mac RAM 
upgrades. When seeking RAM 
specifications, I visit TechWorks. 
This site allows you to look up 
RAM configurations for nearly 
every Mac ever made. Search results 
will tell you how much memory a 
particular one can hold, how many 
RAM slots the computer offers, and 

the kind of RAM the Mac can use. 
Oh, and TechWorks will sell that 
RAM to you, too. Although I’m a 
satisfied customer, TechWorks is 
hardly the only memory merchant 
on earth, and many others offer 
similar guides (Kingston and 
Ramjet, for example).

You can put a hard drive as 
expansive as 120GB into your 
iMac. If this isn’t enough storage, 
consider using a higher-capacity 
external FireWire drive. And if 
you’re running OS 9 on this iMac, 
make sure you’re running version 
9.2 or later. Earlier versions of OS 
9 require third-party drivers before 
they’ll recognize FireWire drives.

Fat Bits, Conejo Valley MUG

Stereogram X
Q: Is there an application for 

Mac OS X that creates those cool 
Magic Eye stereograms?

A: Magic Eye-style stereograms 
are those tiled, colored pictures that 
reveal a hidden 3D image when 
you cross your eyes. To make your 
own, use Laine Lee’s Absird 1.1 
(free, http://lonestar.utsa.edu/llee/
applescript/) — all you need is a 
black-and-white JPEG to use as the 
hidden 3D image and another small 
JPEG to tile.

MacAddict Magazine

World Photos
TrekEarth.com is creating 

a global community for those 
interested in photography from 
all over the world. Browse this 
gallery of beautiful and inspiring 
photographs, join one of the forums 
to discuss and critique the images, 
or submit one of your own pictures 
to this cool site.  
http://www.trekearth.com/  
~ Patrish Blackstock

Mouse Droppings, Corvallis, OR

Apple Repair Extension Programs
Over time Apple has helped out 

their customers by hooking them 
up with programs to fix faulty 
hardware issues.

To replace an older G3 
PowerBook power supply:
http://depot.info.apple.com/
exchange/

To replace the screen on a 
Titanium PowerBook or Aluminum 
PowerBook that has white pressure 
marks around the Apple Logo and a 
serial number within the following 
ranges:

V7334xxxxxx to V7345xxxxxx 
QT331xxxxxx to QT339xxxxxx

http://www.apple.com/support/
powerbook/displayprogram/

For a G3 iBook with a video 
issue, a no-video issue, or an 
intermittent video issue:
http://www.apple.com/support/
ibook/faq/

If you have a G4 iBook or G4 
PowerBook that is a year or two old, 
you should use this link to make 
sure that your battery is not faulty:
https://depot.info.apple.com/
batteryexchange/index.html/

If you have a fancy new G5 of 
the first generation, you might want 
to print this out in case you have 
a no-video issue, power issue, or 
scrambled video issue someday:
http://www.apple.com/support/
imac/repairextensionprogram/

These are all the current 
programs that I know of. If you 
know of another one, send a link 
my way and I will help get the word 
out. ~ Troy

Small Dog Electronics  

Switch for Switchers
Q: I am mainly a Mac user, but 

I need to use a PC sometimes. I 
don’t want to take up desk space 
with two keyboards, so I’m looking 

http://lonestar.utsa.edu/llee/applescript/
http://depot.info.apple.com/exchange/
http://www.apple.com/support/powerbook/displayprogram/
https://depot.info.apple.com/batteryexchange/index.html/
http://www.apple.com/support/imac/repairextensionprogram/
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for a KVM switch that will let me 
use a Mac keyboard to emulate a 
PC keyboard. Can you recommend 
one? ~ Robert Sena

A: You don’t necessarily need 
to seek an exotic KVM (keyboard, 
video, mouse) switch for this. (A 
KVM switch lets you control 
multiple computers from a single 
keyboard, monitor, and mouse.) You 
just need to configure Windows so 
that its keyboard mapping matches 
your keyboard’s physical layout. 

There are a couple of choices. First 
is RandyRants.com’s free SharpKeys 
1.1, a Windows registry hack that 
makes certain keys on a keyboard act 
like other keys. The second is AppleK 
Pro’s $25 Apple Keyboard driver for 
Windows, a driver for Windows that 
supports Apple’s USB keyboards 
(among others).

Chris Breen’s Mac 911  
via The Finder, Mid-Columbia MUG, 

Kennewick, WA

Dodgy Discs
Q: I routinely receive large 

files on CDs that were created on 
a Windows PC, and those discs 
fail to mount on my Mac. What 
instructions can I give those 
Windows users so that the discs 
they send me will mount on my 
Mac? ~ Gregory Payne

A: Politely ask your PC pals to 
stop using Roxio’s DirectCD or 
Drag-to-Disc utilities to burn their 
discs. These programs support packet 
writing, which allows you to burn 
files to a CD-R or CD-RW multiple 
times using a file format called UDF 
(Universal Disc Format). 

This format is a convenient way 
to append files to a disc designed 
as write-once, but discs produced 
using it are not Mac-compatible. 
Discs made by other means on the 
PC will almost certainly be burned 

in the ISO 9660 format, which the 
Mac understands completely.

If the disc format doesn’t appear 
to be the problem, check the kind of 
media people are sending you. The 
Mac loves CD-R media but can act 
finicky with CD-RW discs.

Chris Breen’s Mac 911  
via The Finder, Mid-Columbia MUG, 

Kennewick, WA

Free Proofing Guide from EFI
EFI has published a free guide 

called “ABC’s of Proofing.” This 
handy PDF outlines the steps 
necessary to effectively proof a 
project, along with several hints 
and tips to improve your proofing 
process. It also discusses the types 
of hardware and software available 
for proofing, with a slant (of course) 
toward EFI products. Other titles 
in EFI’s ABC series include “ABC’s 
of Workflow,” and “ABC’s of VDP.” 
Just be sure to use a browser such 
as Firefox (free) to download the 
guides because their website uses 
proprietary Microsoft code that 
doesn’t work correctly in Safari. 
www.efi.com www.mozilla.org

Design Tools Monthly

Doctor Mac Direct
Now here’s a good idea. Bob 

“Dr. Mac” LeVitus, one of the 
best-known Macintosh authors, 
has started Doctor Mac Direct, a 
service for remote troubleshooting, 
technical support, and training on 
Mac OS X and Mac 0S 9 software 
(but not hardware; he’s leaving 
that to Apple). You describe your 
problem on the Doctor Mac Direct 
Web site, and one of Doctor Mac 
Direct’s experts, gives you a binding 
estimate of how long it will take 
to solve your issue. If the $120 
per hour rate, billed in 15-minute 
increments of $30, is acceptable, the 

expert then calls you and, using 
Timbuktu-like screen sharing that 
works via a Web browser plugin, 
and solves your problem. Resolution 
is guaranteed.  
http://www.doctormacdirect.com/

TidBITS via
LIMac Forum, Long Island, NY

Eject!
Q: Is there a way to open 

an optical drive tray from the 
command line?

A: Sure is! The secret is the 
“drutil” command. First, get a list 
of possible drives, both internal and 
external, by typing drutil list. If you 
have only one drive, type “drutil 
tray open” to open its tray-oh, and 

“drutil tray close” to (you guessed it) 
close it again. 

If you have more than one drive, 
you’ll need to add the ID number 
from the list (drutil tray open -1 or 
drutil tray open -2, for example).

MacAddict Magazine

PDF Services
One of the handiest things in OS 

X is the ability to print as a PDF file 
instead of printing out to printer. 
Once you gain an appreciation for 
this ability, it is time to look into 
PDF Services.

Wouldn’t it be handy if when you 
find a web page on how to correct 
red eye, if you could place this 
information into your Photography 
folder? Or if you find a great recipe 
page for lobster thermador, you 
could place it in your Recipes folder.

If you like this idea, locate the 
Photograph and Recipe folders in 
your Documents folder, or create 
them. Alias them (Command/L). 
Now go to your user folder (Users 
> username) and scroll down to the 
Library and find the PDF Services 
folder. If there isn’t one, make one. 
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Drop your alias folders here. There 
may already be items in your PDF 
Services folder for other purposes. 
For example, if there is a Mail alias 
in the folder, it lets you attach the 
PDF to a new blank email, ready to 
send. You might want to alias Mail 
for this purpose.

Now go to a web page with a 
recipe you want located on it. Click 
Print (Command/P). At the bottom 
of the dialog, click and hold on the 
PDF icon and you see a list of the 
folder aliases you just made. Select 
one and a PDF of that page appears 
in the correct folder within your 
Documents folder. Keep adding 
folders to PDF Services folder as 
needed. ~ Phil Russell

Mouse Droppings, Corvallis, OR

Computer Repair Tip
Did you ever think of taking 

digital pictures as you disassemble 
anything on your computer? Then 
when you wish to put it back 
together you have pictures to aid 
you. Another repair aid working 
around a computer is a three prong 
parts retriever in case you drop a 
small nut down inside the case.

Mouse Droppings, Corvallis, OR

Command Key
Say after me: “This is the 

Command key, not the Apple key.” 
You will follow instructions much 
more easily if you remember this.  
~ Steve Cooper
AUSOM News, Melbourne, Australia

More on Multisession CDs
Here’s another helpful tool for 

creating multi-session CDs.
http://www.macworld.com/
weblogs/mac911/2005/03/
multisession2/index.php/

The MUG Center  
via TMUG Insider, Pleasanton, CA

Tiger

10.4.4 and MySQL Databases
Several readers emailed us about 

experiences with the new Tiger 
10.4.4 release: [Chris Chapman] 
I’m sure this may help a few web 
developers in a panic out there 
with seemingly broken connections 
to local MySQL databases with 
PHP after performing the 10.4.4 
update. For whatever reason 
after the update, I am unable to 
make connections to the MySQL 
server on my local machine using 
‘localhost’ in the connection string. 
Substituting ‘localhost’ with 
‘127.0.0.1’ seems to correct the 
issue. Note this issue seems to only 
concern connections made using 
PHP. Command line queries work 
perfectly fine using ‘localhost’. I 
am running MySQL 4.1.16 with 
PHP 4.3.11, for what it’s worth. I’ll 
follow-up with more details as I 
uncover them.

Lynn Rybarczyk

Read to Succeed
When it came time for me 

to make the jump to Panther, I 
used the Take Control series of 
Panther-oriented titles to get me 
through it, which they did, and 
quite nicely too. I’ll be doing the 
same thing when it comes time 
to migrate my main system to the 
new OS. The Take Control eBooks 
are short (most are 60 pages or so 
in length), concise they are always 
written about a single topic and best 
of all they’re affordable! Most are 
only $5 while a few longer ones sell 
for $10. There are currently 4 titles 
devoted to installing, customizing, 
and understanding Tiger; separately 
they cost $25 but you can get them 
all for only $20. Find them, as well 
as all the Take Control books, at 

http://www.takecontrolbooks.
com/ and if you decide to purchase 
any, get another 10% off by using 
the User Group Discount coupon 
code at checkout. Which would be 
CPN312O8MUG.

If you can’t spare any 
money right now, there is still 
something that can help you... 
and it’s completely free! O’Reilly, 
the famous technical book 
publisher, has a site called the 

“MacDevCenter” that has lots 
of free articles on all aspects of 
Macintosh use. They recently posted 

“Everything You Need To Know To 
Install Tiger” which can be found 
at http://www.macdevcenter.
com/pub/a/mac/2005/04/29/
tiger.html/. It’s an extensive article 
with lots of cross references to 
other MacDevCenter articles on 
even other web sites. I felt it may 
be unwieldy to some of you with 
slower Internet connections, so I 
created a standalone PDF version of 
the file, complete with all the cross 
references embedded in it. You’ll 
find it on my iDisk as mentioned 
previously. Check it out: while not 
as graphically engaging and lucid 
as the Take Control books are, it 
should be good enough to help you 
get through the installation process 
without a scratch.

MacValley Voice, Northridge, CA

Tiger Books
Whether you’re installing Mac 

OS X for the first time or simply 
upgrading to Tiger, it’s handy (and 
may be essential) to have some 
sort of manual to help you get 
acquainted with the new system 
and make sure you don’t miss any 
useful features.

Peachpit Press, long a solid 
presence in the Mac publishing 
world, has an excellent information 

http://www.macworld.com/weblogs/mac911/2005/03/multisession2/index.php/
http://www.takecontrolbooks.com/
http://www.macdevcenter.com/pub/a/mac/2005/04/29/tiger.html/
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page at http://www.peachpit.com/
promotion/2304?redir=1/.

I particularly recommend the 
Visual QuickStart Guide for the 
basics, and the Robin Williams’ 
book as a comprehensive manual. 
For those who just need to catch 
up on the new features of Tiger, 
the Killer Tips book will be great 
if it follows the format of its 
predecessors.

Note that some of these books 
have not yet been published — click 
a title on the Peachpit web page to 
go to a page describing the book’s 
content and giving both expected 
publication date and ISBN number, 
which will help you track the book 
down at local bookstores if that’s 
your desire.

Another recommended book 
not listed at Peachpit will be Mac 
OS X Tiger — The Missing Manual 
by David Pogue. (Search for 

“macintosh tiger” at Amazon or your 
online bookstore of choice.)
AUSOM News, Melbourne, Australia

iTunes

Converting iTunes File Formats
Need to convert an AAC music 

file into MP3 format? Need to 
convert an MP3 file into WAY? Use 
iTunes to convert files already in 
your iTunes library into different 
formats. To convert music files from 
one format (e.g. AAC) to another 
(e.g. MP3):
•	 Open iTunes
•	 Click on iTunes > Preferences
•	 Click on the “Importing” button 

at the top of the window
•	 From the “Import Using” pop-up 

menu, click on the encoding 
format (AAC, AIFF, Apple 
Lossless, MP3, WAY) you wish 
to convert your music files to

•	 Click on “OK” to save the 
settings

•	 Select one or more songs in 
your iTunes library to convert 
(Command/click to select specific 
individual files or Shift/click to 
select files in a row)

•	 Click on Advanced > Convert 
Selection to... (the format you 
selected in preferences above is 
displayed)
A copy of the file (or files) will be 

created in the new format.
Rachael Smithey, Your Guide to 

Focus on Macs via TMUG Insider, 
Pleasanton, CA

Different Formats and Quality
Anyone who has ripped an 

audio CD (that is, converted and 
imported its contents) in iTunes 
knows what a simple process it can 
be. Insert the CD, wait for iTunes 
to download track information from 
the Internet, click on the Import 
button, and go about your business 
while iTunes does its business. 
What you may not know is that you 
have a choice when it comes to the 
format in which iTunes imports 
that CD.

iTunes and the iPod support 
four audio formats — AIFF, WAV, 
MP3, and AAC. AIFF and WAV 
files are uncompressed and consume 
about 10MB of hard-drive space 
for each minute of stereo audio. 
MP3 files are compressed (stripped 
of audio data considered to be 
less detectable to the human ear). 
With iTunes 4, Apple added a new 
audio-compression format: Dolby 
Laboratories’ Advanced Audio 
Coding (AAC).

By default, iTunes 4 rips CD 
audio files at 128 Kbps to about 7 
percent of the original file size. But 
if you’re willing to trade hard-drive 
space for better sound quality, you 

may want to change iTunes’ default 
import settings. 

To do so, select “Preferences” 
from the iTunes menu and click 
on the “Importing” tab. Selecting 

“AIFF Encoder” or “WAV Encoder” 
from the “Import Using” pop-up 
menu provides you with full-quality, 
uncompressed music tracks — 
useful for purists — but these files 
will take up a load of space on your 
Mac or iPod. 

A better compromise is to leave 
AAC Encoder selected and bump 
up the resolution. 

To do this, select “Custom” from 
the Setting pop-up menu beneath 
AAC Encoder, and choose a higher 
bit rate from the Stereo Bit Rate 
pop-up menu.
Apple Pickers MUG, Indianapolis, IN

Making a Podcast: The Basics
This is not meant to create a 

professional podcast, but just to 
learn how to make one quickly and 
for fun. Tools I used:
•	 12-inch PowerBook G4 

Aluminum (1GHz, 768MB 
RAM)

•	 GarageBand 2.0.1
•	 Audio Hijack Pro
•	 iTunes 5.0
•	 Podcast Maker

I found Podcast Maker by Potion 
Software on Apple’s website. It is a 
shareware application, but I feel it’s 
worth the $30 to upgrade to the full 
licensed version. Next you’ll need 
GarageBand, which comes in the 
Apple iLife package. I have mine 
updated to version 2.0.1, though 
this isn’t necessary. Next is Audio 
Hijack Pro. I used this so I could 
record audio, such as the intro to 
the podcast, from my computer. I 
used Text Edit, had the computer 
read what I wrote, and Audio 
Hijack recorded it.

http://www.peachpit.com/promotion/2304?redir=1/
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My podcast is of the music I’ve 
been listening to for the past week. 
That makes it really simple, because 
to get my songs into GarageBand I 
just drag and drop them. I use the 
volume level so the songs seem to 
blend into each other. I use Audio 
Hijack to record some intro and 
exit vocals from Text Edit. I can 
also use GarageBand to record my 
actual voice announcing the titles 
of the songs and then plop them 
into the correct places.

Once my songs and titles are 
in the right places in GarageBand, 
I export the entire thing. 
GarageBand exports as an AIFF file, 
which can be imported into iTunes 
and converted to an MP3 file. You 
can choose whatever format you 
like (in iTunes preferences); I chose 
MP3 for an example.

Once you’ve exported and 
converted the podcast, it’s time 
to start making it into an actual 
podcast. Open up Podcast Maker 
and you will be presented with a 
window that says Podcast Title, 
Author, Description and a little box 
that allows you to insert an image. 
Fill out the information. 

You can also give your podcast 
a little image that will show up in 
iTunes. Next, you’ll want to get 
your MP3 file you made in iTunes 
and drag and drop it into the 
designated area in Podcast Maker 
(it tells you where to drag and drop 
it). Once you do that, you can edit 
the description of that individual 
podcast and give it a name. 
Using the Detail tab, you can set 
keywords for your podcast and also 
its genre. Clicking on the Chapters 
tab allows you to make your 
podcast “enhanced,” and will allow 
users to jump back and forward 
between marked chapters. I used 
them so I could try out as many 

of the features of this program as 
possible. You can add album art 
and a title for each song, which was 
pretty cool.

Now everything is basically 
complete. You might want to check 
the details of your podcast. Once 
you feel that it’s complete and all 
the information has been filled 
out, you’re ready to publish. You 
will need your own web server 
with space on it for your podcast. I 
have my own personal servers, so 
I publish my podcast to them. But 
since publishing to an FTP server 
(which is a built-in option) isn’t 
that great, I publish the podcast to 
my local computer first and then 
upload it. You can do it either way, 
but I felt that publishing locally 
was easier.

Once you’ve published your 
podcast, you can share it with 
friends and family and anyone. You 
can even submit it to iTunes so that 
people all over the country can hear 
it!

For more information, check out 
the following sites:
Audio Hijack Pro: http://www.
rogueamoeba.com/audiohijackpro/
iTunes 5.0: http://www.apple.
com/itunes/
Podcast Maker: http://www.
potionfactory.com/
~ Jimmy Brancaccio

Small Dog Electronics

Pardon Me,  
Your Toast is Burning

And some people’s tempers are 
going to be pretty hot when they 
see this little item in the ReadMe 
for the new, Tiger compatible 
version 6.1 of Toast Titanium:

“Audio Following discussions 
with Apple, this version will no 
longer allow customers to create 
audio CDs, audio DVDs, or export 

audio to their hard drive using 
purchased iTunes music store 
content.”

Personally this doesn’t bother me 
that much. I’m kind of surprised 
people were able to do this up until 
now, as rights management such as 
it is in iTunes is what enables the 
music store to exist in the first place. 
And iTunes does a fine job at letting 
users burn CDs from playlists with 
just one click (although there’s now 
a 7-disc limit on any single playlist 
containing purchased songs, down 
from an initial 10), so I wouldn’t 
lose any sleep over this.

MacValley Voice, Northridge, CA

Access Music in iTunes  
Without Adding to Library

I have been trying to find a way 
to access music in iTunes without 
adding it to the library. 
www.macosxhints.com/article.
php?story=20050413022159670

The MUG Center 
via TMUG Insider, Pleasanton, CA

Bookmark the Apple Music Store
In Safari, to have a bookmark 

take you directly to the Apple 
Music Store, select “Show All 
Bookmarks” from the Bookmarks 
menu, choose any bookmark, Copy 
it. Paste it. In the Copy, change the 
Address to the following: itms://
phobos.apple.com/WebObjects/
MZStore.woa/wa/com.apple.jingle.
app.store.DirectAction/viewAlbum
?playlistId=395839

Change the Bookmark name to 
Apple Music Store. Now you can go 
directly from your browser to the 
Music Store. 

In Chimera, create the new 
Bookmark you need, open Sidebar, 
select the Bookmark you just 
created, choose the Pencil editing 
tool at the top of the Bookmarks 

http://www.rogueamoeba.com/audiohijackpro/
http://www.apple.com/itunes/
http://www.potionfactory.com/
http://www.macosxhints.com/article.php?story=20050413022159670
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page and make the changes to 
name and address. 

In Explorer, create a new 
Favorite for a page you are not 
interested in using, Open Organize 
Favorites from the Favorites menu. 
Select the new Favorite you created, 
Get Info... (Command/I) and make 
the changes to name and address.

Mouse Droppings, Corvallis OR 

9-Step Program
If you encounter an Error 400 

message while visiting the iTunes 
Music Store on a Mac with iTunes 
4.8, use these steps to resolve the 
issue:
	 1. 	Quit iTunes;
	 2. 	Open Safari;
	 3. 	From the Safari menu, 

choose Preferences;
	 4. 	Click the Security icon in 

the top row;
	 5. 	Click the Show Cookies 

button;
	 6. 	In the resulting dialog, 

scroll down the list of cookies 
until you see the “.apple.com” 
cookies;

	 7. 	In the Name column, select 
all the apple.com cookies that 
start with “s_vi_” and then 
click Remove;

	 8. 	Click Done; 
	 9. 	Open iTunes and connect 

to the Music Store.
To see these steps illustrated 

with screen shots, go to http://
docs.info.apple.com/article.
html?artnum=301628/

MacValley Voice, Northridge, CA

iPod

On the Go-Go-Go
Q: How do I create multiple 

On-The-Go playlists on my iPod ? 
— from the Macworld.com forums

A: To create an On-The-Go 
playlist on your iPod, select a song, 
genre, artist, composer, or album, 
and then press and hold the iPod’s 
center button until you see the entry 
blink. Travel to the Playlists screen, 
select the “On-The-Go” entry at the 
bottom of the screen, and press the 
center button. Scroll to the bottom 
of the resulting On-The-Go screen, 
select “Save Playlist,” and press the 
center button again. Finally, in the 
Save screen that appears, choose 

“Save Playlist” and press the center 
button once more. This saves the 
playlist as Playlist 1. The numbers 
in the names of subsequent playlists 
created in this fashion will rise 
in increments of one — Playlist 
2, Playlist 3, Playlist 4, and so on. 
You’re now ready to create a new 
On-The-Go playlist and save it in 
the manner just described.

Chris Breen’s Mac 911  
via Mouse Droppings, Corvallis, OR

Today @Playlist: iPod EQ  
and You

Confused by how EQ settings 
are implemented on your iPod? 
Here’s the dope.
http://playlistmag.com/weblogs/
todayatplaylist/2005/04/
eqandyou/index.php?1src=mwrss-
0405/

The MUG Center  
via TMUG Insider, Pleasanton, CA

iPhoto

Keyboard Shortcuts  
to Speed iPhoto

In iPhoto 5 or above, there are 
three keyboard shortcuts that can 
speed iPhoto considerably:

In Browse mode, press the 
“2” key to tell iPhoto to display 
thumbnails at their native size, 

which is 240 pixels high or 
wide. You’ll see a dramatic speed 
improvement because iPhoto 
then doesn’t have to scale all 
those thumbnails to display them. 
Pressing the “0” key produces very 
small thumbnails, and pressing 
the “1” key tells iPhoto to enlarge 
the current thumbnail to fit in the 
window. (When viewing an Album, 
you may need to click on one 
photo first.)

In Edit mode, press “0,” “1,” or 
“2” to change the zoom level of your 
image. “0” zooms to Fit in Window; 

“1” is 100% (one display pixel = one 
image pixel); “2” is 200% zoom.

Design Tools Monthly

iPhoto Miscellany
iPhoto is a great application 

and I use it extensively, but it does 
have one strange characteristic that 
I’ve seen cause difficulty for others 
— hence this mention.

If you put a photo into Edit 
mode (by clicking the Edit button 
while in Organize mode) you may 
notice some strange phenomena. 
Sometimes the photo is very blurry 
when it first appears in full size but 
then sharpens up, and sometimes the 
opposite happens.

Whichever way things go, you 
need to be aware that the final 
image is almost always “softened” 
somewhat; that is, it is not as sharp 
(or “in focus”) as the real thing will 
appear when you print it. Why 
Apple thinks this is a good idea 
nobody seems to know, but it surely 
causes some concern among users 
whose photos never seem to be as 
sharp as they ought to be.

To get a better idea of a photo’s 
real sharpness, use the mouse to drag 
a selection rectangle across almost 
the whole photo, and don’t release 
the mouse button, while you inspect 

http://docs.info.apple.com/article.html?artnum=301628/
http://playlistmag.com/weblogs/todayatplaylist/2005/04/eqandyou/index.php?1src=mwrss-0405/


Page � • March 2006 www.mac-hints-tips.com

the result. When you do release the 
button, the photo will return to 
its “soft” appearance. You can then 
click outside the photo to release the 
selection.

On another subject entirely 
— did you realize that when you 
make any kind of modification 
at all to a photo in iPhoto (even 
just rotating it), iPhoto keeps an 
unmodified copy — the “Original” 

— just in case you want to return to 
it, which you can do by using the 
menu command Photos > Revert to 
Original.

The problem is that if you do 
much editing in iPhoto, or even 
rotate many of your photos, the 
presence of the kept Originals can 
bloat the size of your iPhoto Library 
significantly. There is, however, a 
way to clean them out. The freeware 
utility iPhoto Diet (now at version 
2.2) will do just that. If you are 
really short of disk space it will also 
remove the “thumbnail” images 
which enable your photos to display 
mini-versions of themselves as 
icons when you look at them in the 
Finder. iPhoto Diet can be applied 
to any iPhoto Library, should you 
have more than one.  
http://pages.cpsc.ucalgary.
ca/~fuhrer/personal/freestuff/
iphotodiet/.  
~ Steve Cooper
AUSOM News, Melbourne, Australia

Moving iPhoto Libraries
Q: I would like to move photos 

(in iPhoto) from a PowerBook G4 
with OS 10.3 to my new iMac G5 
with OS 10.4. I would like to keep 
the albums as well. What is the 
easiest way to go about this, and is 
it even possible?  
~ Alden Woolfanay

A: It is definitely possible. The 
first thing you will want to do is 

make sure you are running the same 
version of iPhoto on both Macs. 
Once you have that out of the way, 
you can make preparations to move 
your photo library to the iMac. Go 
to the PowerBook and, in the Finder, 
choose Go > Home. You will see 
a folder called Pictures. It is this 
folder that you will need to move to 
the iMac. You can make the move 
in a number of ways, including file 
sharing over Ethernet and burning 
the folder to DVD. The easiest way 
to transfer the folder though, is 
through FireWire Disk Mode. This 
feature allows you to connect your 
computers through FireWire, with 
one computer acting as an external 
hard disk. To do this, you will 
need a 6-pin to 6-pin FireWire 
cable, which you can find at most 
computer stores for under $20.

Turn off the PowerBook, and if 
necessary, plug in its power cable. 
Now connect the PowerBook to the 
iMac using the FireWire cable. Go 
back to the PowerBook, hold down 

“T” and then turn it on. In a few 
seconds, you should see a yellow 
FireWire icon appear on the display, 
indicating that the computer is 
now in FireWire Disk Mode. Go 
back to the iMac. The PowerBook’s 
hard disk will now be visible in the 
iMac’s Finder.

Open two Finder windows on 
the iMac, and place them adjacent 
to each other. In the first window, 
choose Go > Home to show the 
iMac’s Home folder. You will see 
the iMac’s Pictures folder, which 
you will soon replace. (If you have 
anything valuable in the iMac’s 
Pictures folder, rename it “Pictures 
Backup” to keep it safe.) Now, in 
the second window, choose Go 
> Computer and double-click the 
PowerBook’s hard disk icon. You 
will find the PowerBook’s Pictures 

folder at Macintosh HD > Users > 
YourUserAccount. Drag this folder 
into the first window. 

You will be warned that a 
similarly named folder already exists 
in that location. Click “Replace” to 
overwrite it. The computer will then 
copy the folder to the iMac. Once 
it is done, eject the PowerBook’s 
hard disk by clicking it and pressing 
Command/E. You can then turn 
off the PowerBook and power it 
up normally. Go back to the iMac 
and open up iPhoto. It should look 
identical to how it looked on the 
PowerBook, complete with any 
albums, slideshows, and books you 
may have created.

macHOME Journal
via TMUG Insider, Pleasanton, CA

Apple Mail

A Matter of Some Import
Q: When I launch Mail 2.0 

in Tiger, it starts importing old 
messages from Mail 1.0. Apparently, 
there’s an old sent-mail message 
that Mail 2.0 doesn’t like: the 
application hangs on one message 
and stops importing sent mail. 
When I cancel, the whole thing 
stops. I’ve tried launching Mail 
again, but the whole process repeats. 
Where does that old message live? 
I’d like to delete it before I launch 
Mail 2.0, and skip the import step 
altogether. ~ Jeff Hounshell

A: You’ll find all of Mail’s 
mailbox files (called mbox files) 
by following this path: /your 
user folder/Library/Mail/name of 
account, where name of account 
is the name of your email account 

— POPtestingmail.example.com 
for example. Inside this folder is a 
Sent Messages.mbox folder. Give 
this folder the bum’s rush (in other 

http://pages.cpsc.ucalgary.ca/~fuhrer/personal/freestuff/iphotodiet/


March 2006 • Page �www.mac-hints-tips.com

words, delete it); that should fix the 
problem.

You can also choose to import 
some of your old mail by choosing 
File > Import Mailboxes. In the 
Import dialog box that appears, 
select the Mail For Mac OS 
X option, click on “Continue,” 
and select the account folder 
from which you want to import 
messages. In the next window, 
choose the mailboxes you want to 
import and click on “Continue.” 
This will place your old mail in an 
“Import” folder in Mail’s sidebar. 
Alternatively, you can enable 
the “Other” option in the Import 
window and selectively import 
individual mbox files.

Chris Breen’s Mac 911  
via The Finder, Mid-Columbia 

MUG, Kennewick, WA

Killing the Messenger
Q: In Apple’s Mail, is there any 

way to block the messages from a 
specific sender?  ~ Sid Koss

A: Your ISP is the only one 
that truly has the power to block 
messages, and few ISPs offer such 
a service. You can, however, create 
a Mail rule that deletes messages 
from particular individuals. Go 
to Mail: Preferences and click on 

“Rules.” Click on “Add Rule” and 
type a name (for example, Get 
Lost!) in the Description field. 
Then use the pop up menus to 
create a mail rule that reads:
From Contains joeexample.com
Delete Message

Note that applying this rule isn’t 
such a hot idea if you’ve recently 
had a spat with your significant 
other and have sworn that you’ll 
never speak to him or her again. 
Such a rule could easily delete the 
groveling make up note that person 
sends your way. A better option 

is to create a new mailbox (called 
Sniveling Worm, say) and create a 
rule that moves mail from your ex 
into this folder. To do this, create a 
rule that reads as follows:
From Contains joeexample.com
Move Message To Mailbox: Sniveling 
Worm

When you want to let bygones 
be bygones (or want to revel in 
your former sweetie’s despair), fling 
open this mailbox and read the 
messages you’ve diverted.

Chris Breen’s Mac 911  
via Mouse Droppings, Corvallis, OR

Where are Blind Carbon Copies
Q: Am I missing something or 

did we lose a nifty BCC feature in 
the last several versions of Mail?

A: Look at “Subject” box. Under 
that there’s a little icon with an 
arrow pointing down and three 
little lines. Click on that and you’ll 
see the option to add the BCC 
field. You’ll also see a “Change 
Reply-To” address field, which is 
nice if you want people to reply to 
an email address other then the 
one you’re sending from. I hope 
this is what you’re looking for. If 
not, let me know.  
~ Jimmy Brancaccio

Small Dog Electronics 

InDesign

Quick-Apply Styles
InDesign CS2 now lets you 

access all of your styles directly 
from the keyboard. Just press 
Command/Return and a small 
window will pop up on your screen. 
Type the first few letters of the 
style name and press Return. Your 
style will be applied without ever 
touching the mouse.

Layers Magazine

Viewing Changes  
as You Make Them

When you rotate, move, crop, or 
resize a frame, InDesign usually 
only shows you a gray outline of the 
box. If you hold down the mouse 
button for about half a second 
before you move it, you can see the 
actual picture or text change as you 
manipulate it.

David Blatner’s Tips & Tricks  
by ALAP, Inc.

Snippets
Drag an element from a layout 

to Adobe Bridge. The item will turn 
into what’s known as a “snippet.” 
These snippets are saved in what’s 
known as an INX (InDesign 
Exchange) format and can then be 
dragged into any InDesign layout. 
In addition, designers can create 
snippets and email them to others 
to re-create parts of pages instantly.

Layers Magazine

Inline Graphics in Word Files
When you import inline graphics 

in a Word file, InDesign places 
them as anchored objects and 
positions them using the original 
Word dimensions and parameters. 
You can modify these settings 
by selecting the anchored object 
and choosing Object > Anchored, 
Object > Default Options.  
~ Peachpit Press

InDesign Magazine

Use Multiple Views  
of the Same Document

Sometimes you need to be 
zoomed in and out at the same time. 
Without causing a rift in the space-
time continuum, you can simply 
choose Window > Arrange > New 
Window. This will give you another 
view of the same document so you 
can zoom in or out. You can even 
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tile the windows to see both views 
at the same time.

Layers Magazine

Adding More Pages in InDesign
Need to add more pages to your 

document? Command/Shift/P adds 
one new page after the currently-
targeted one. Also, don’t forget that 
Option/Clicking on the “New Page” 
button in the Pages palette opens 
the “Insert Pages” dialog box, which 
lets you specify the number of pages 
to insert, where to insert them and 
what master pages should be used.  
~ David Blatner

LIMac Forum, Long Island, NY

Getting Text to Ignore Text Wrap
There may come a time when you 

want to place a block of text over an 
image that’s repelling other text. 

To do this, select the text you 
want to ignore the text wrap applied 
to the underlying object and 
then choose Object > Text Frame 
Options or press Command/B. 
Select the “Ignore Text Wrap” check 
box and click “OK.” It couldn’t be 
any more convenient!

LIMac Forum, Long Island, NY

Reset Dialog Box Settings
Have you ever entered settings in 

a dialog box in InDesign and, after 
looking at the preview, realize you 
need to start over again? Of course 
you have! Who hasn’t? Rather than 
clicking the Cancel button, though, 
you can simply hold down the 
Option key in several of the dialog 
boxes in InDesign to change the 
Cancel button to the Reset button. 
Click the Reset button to clear the 
fields and enter new settings. It sure 
beats having to repeatedly reopen a 
dialog box!

Element K Journals 
via LIMac Forum, Long Island, NY

Direct Select a Path
Normally, when you use the 

Direct Select tool to click on a 
path, you select either a point or 
a segment on that line. Option/
clicking selects the whole path. If 
the path is just one among several 
paths within a compound path, 
then Option/clicking a second time 
will select all the points on all the 
shapes in the compound path.

David Blatner’s Tips & Tricks  
by ALAP, Inc.

Leading Tips
The wider your column of text, 

the more leading you need. Solid 
leading (such as 12 point text on 
12 points leading) produces almost 
unreadable text for all but the 
narrowest of lines. However, the 
larger the text, the tighter leading 
you can usually get by with. Solid 
leading (or even leading that is 
smaller than the font size) may be 
possible with large headline type.

David Blatner’s Tips & Tricks 
by ALAP, Inc.

MS Entourage

Entourage’s Message Font
Q: How can I change the default 

font that is used for composing 
outgoing messages in Entourage 
2004? Right now it is set for 
Verdana. I’d like all new outgoing 
messages to use Textile. Is there any 
way to do this? ~ Ray Taylor

A: You can certainly change the 
font used for outgoing messages in 
Entourage. The first thing you’ll 
need to do is tell the application 
that all outgoing messages are 
to be sent as HTML. This is the 
only way an outgoing message 
can convey your font preference. 
Choose Entourage > Preferences. 

You’ll see a list of categories at the 
left. Click “Compose,” and a set of 
related options will appear at the 
right. You’ll see a pop-up menu 
that determines the mail format; 
choose “HTML.” Now you can set 
the font. Click “Fonts” from the list 
at the left to call up the four fonts 
options. The second item listed 
is HTML Messages. Choose the 
preferred font (Textile) and your 
preferred font size, then click “OK.” 
All new outgoing messages will now 
be HTML in format with Textile as 
the default font.

There’s a hitch, though, that 
you need to know about before 
you make the switch. Recipients of 
your message must have the same 
font installed on their computers; 
otherwise, they’ll just see the 
message with their own default 
font. It’s a good idea to limit your 
font choices to standards such as 
Times New Roman or Helvetica, 
or fonts such as Arial and Verdana 
that are included with most 
Microsoft applications.

macHOME Journal

MS PowerPoint

Quite a Character
Q: I just upgraded to Microsoft 

PowerPoint 2004, and now, when 
I launch the program, I see an 
alert that displays what appear to 
be Asian characters and a message 
that claims this font is unavailable 
on my computer. My presentations 
don’t use this font, so why the 
substitution? ~ Ken Chupp

A: PowerPoint 2004 displays this 
error message when it’s missing an 
Asian font that is installed with OS 
X or a font that Microsoft Office 
installs when it first runs. The 
missing Apple font is likely to be 
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Hiragino Kaku Gothic Pro, and the 
Microsoft font is MS PMincho.

At this point, you have a couple 
of options. You can enable the fonts 
(or install them if they’re missing), 
or you can tell PowerPoint to live 
without them.

To instruct PowerPoint to 
proceed without certain fonts, 
open your PowerPoint presentation 
and choose Format: Replace 
Fonts. Select the Asian font in the 

“Replace” pop-up menu, choose 
something more appropriate in the 

“With” field (Times, for example), 
and click on “Replace.” The new 
font you’ve selected will replace all 
instances of the old one.

With luck, these fonts may 
still be on your Mac. To find out, 
launch Panther’s Font Book, select 

“All Fonts” from the Collection 
column, and peer into the Font 
column. If one or both fonts are 
disabled, select them and click on 

“Enable.”
If the Hiragino font is missing, 

you could get it back by reinstalling 
OS X, but there’s an easier way. 
Download Charles Srstka’s $20 
shareware utility Pacifist, and use it 
to extract the font from the Panther 
installer disc(s). You’ll find the font 
by following this path: Contents 
of OSlnstall.mkpkg/Contents of 
EssentialSystemSoftware.mkpkg/
Contents of Essentials.pkg! System/
Library/Fonts.

Note that the font’s name 
includes a series of Japanese 
characters that you might not be 
able to read. The font you want 
has a name that ends with Pro 
W4.otf, and it weighs in at 9.6MB. 
It normally lives in the Fonts folder 
within the System folder — a folder 
for which you lack permissions. 
If you’d rather not change those 
permissions, simply add the font 

changes, Excel asks if you want to 
save the changes to any unsaved 
workbooks.

TMUG Insider, Pleasanton, CA

Acrobat

PDF Skeleton Key
Q: How can I print or edit 

password-protected PDFs?
A: That depends on what exactly 

the password is protecting. If the 
PDF is locked so tight that you 
need a password to even open it, 
then sorry, no dice. If it’s simply 
locked against editing or printing, 
you can use PDFKey Pro (www.
pdfkey.tk) to create an identical, 
unlocked copy of your PDF. This 
utility costs about $12 at press time.

MacAddict Magazine

Panes-to-Palettes in Acrobat
You can change Acrobat’s 

Bookmarks and Thumbnail panes 
into free-floating palettes by 
dragging them into the document 
pane.

Design Tools Monthly

Use Preview to Add Comments  
to PDFs

Apple’s Preview application 
in Tiger lets you add comments 
to PDF files. Open the PDF in 
Preview, then go to the “Tool 
Mode” section of the tool bar. 
There you’ll see a button that lets 
you choose “Text Annotation” 
or “Oval Annotation.” Text 
Annotation adds Post-it-like squares 
of text to your PDF, while Oval 
Annotations can circle items you 
want to call attention to.

MacAddict Magazine  
via Design Tools Monthly

to your user account’s Font folder 
(your user folder/Library/Fonts).

If the Microsoft font is missing, 
insert your Office 2004 disc, open 
the Microsoft Office 2004 folder, 
the Office folder therein, and then 
the Fonts folder inside that folder. 
Copy the MS PMincho font to your 
user account’s Fonts folder.

Chris Breen’s Mac 911  
via TMUG Insider, Pleasanton, CA

MS Excel

Keep a Cleaner Desktop  
when Multitasking

Are you one of the many busy 
Excel users who frequently have 
two, three, or more workbooks 
open at once? If so, you know that 
kind of multitasking can create a 
lot of screen clutter.

Within the Excel window, you 
can navigate between workbooks 
by pressing Command/F6 or by 
opening the Window menu and 
selecting a workbook from the list 
of open files.

Excel offers an option that can 
help you avoid screen clutter while 
keeping as many workbooks open 
as you like. To try it out, open 
three or four workbooks, and go 
to Window > Hide. When you do, 
Excel erases all traces of the current 
workbook from your screen. The 
workbook is still open, but you 
can’t see it.

To make a hidden workbook 
visible again, go to Window > 
Unhide, and you’ll see a list of 
the hidden workbooks. Select the 
workbook name that you want to 
display, and click OK.

Don’t worry about forgetting 
that you have a workbook open. If 
you close Excel while a workbook is 
hidden and you haven’t saved your 

http://www.pdfkey.tk
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